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Getting Started
Key Concepts: Parts of a Timeline
Events
A timeline is composed of a series of events: an occurrence that happens at a
particular time and place for a given duration.
Events are represented graphically on the timeline with their title, color, date and
duration. Events have a number of additional properties that can be configured,
including notes, tags (keywords), other properties, and relationships with entities,
which can be viewed on the timeline by expanding an event.

Entities
Aeon Timeline allows you to associate events with people, locations, projects, story
arcs, and more – collectively known within Aeon Timeline as entities. Entities have a
name and a type (e.g. Person, Location) as defined in the chosen template, and
can have relationships with any number of events.
Entities can also have start/birth and end/death dates or events, from which Aeon
Timeline can calculate ages.

Relationships
Relationships represent a connection between an event and an entity. This may
represent a particular person was present at an event, or an event belongs to a
particular story arc or project.
Relationships are many-to-many, meaning each event can have relationships with
multiple entities, and each entity may have relationships with multiple events.
When specifying a relationship, you also specify the role that the entity fulfils for that
event. Many entity types may only allow a single role, but some types may have
multiple roles – for instance, a person may be a participant in an event, or just a
witness. Roles are defined in the timeline’s template.

Groups
Aeon Timeline can visually divide events into a number of groups based on their
relationships with particular entities. If you choose to group by Person, for instance,
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there will be a separate group created to represent each person. Likewise, you may
group by story arc or location or project.
An event can be displayed in multiple groups.

Templates
Each time you create a new timeline, you will do so by choosing an initial template.
Templates define the following information about a timeline:
• The timeline style (absolute date, relative date, numeric) and calendar
• Entity types and their roles
• Additional properties users can create for an event
• Colors to be associated with an event (and their name)
Aeon Timeline ships with a range of standard templates for fiction writers, project
managers, legal practitioners, and historians. The initial template can be edited via
Timeline Settings, and saved as a custom template for you to use in future.

Filter
Aeon Timeline allows the user to apply a filter to reduce the number of events shown
on the timeline at once. Events can be filtered based on their relationships, tags,
dates, duration, colour, and property values.
Individual filter components can be combined together using either AND or OR logic
to create more complex filters.

Aeon Timeline User Manual

!2

!

Aeon Timeline

Getting Started: Creating Your First Timeline
Choosing a starting template
Aeon Timeline uses editable templates to give you complete flexibility in tracking the
data you want to track. You can choose from a number of pre-configured standard
templates as a starting point for your new timeline, depending on your intended use.
When Aeon Timeline first opens, you will be presented with the Welcome Screen.
The main area of the window will show you the available templates.
Hover your mouse over the i symbol on any of the timelines to read a short
description of the template. Double click on a template to create a new timeline using
that template as your base.
Don’t panic, you can edit your chosen template any time!

The Welcome Screen

Aeon Timeline User Manual

!3

!

Aeon Timeline

Creating your first event
To create an event in your timeline, you can do any of the following:
• Click on the Add Event icon in the toolbar !
• Choose Add Event from the Timeline menu.
• Double click on the date you want to place your event.
All of these options will bring up the Add Event Dialog. Enter a title for the event,
select a color, and modify the date and duration as required. All of these values can
be changed later in the Inspector on the right-hand side of the screen. You can
ignore the other fields for the moment.
When you have entered all of the information, click Add Event at the bottom of the
dialog.
Generally speaking, double clicking on the timeline will be the quickest way for you
to add subsequent events, as the date field will be pre-populated based on where
you clicked.
You can move existing events by dragging them around the timeline, or by selecting
the event and then editing event details in the Inspector.

The Add Event Dialog window
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Adding Entities and Relationships
As you add more events and your window fills up with events, you may wish to add
further elements to your timeline to help keep everything organised.
To add your first entity to your timeline, click on the Add Entity toolbar icon !
and
select a type (e.g. Person). This will bring up the Add Entity Dialog. Enter a name
for your new entity and click OK.
Once you have added an entity, you will be able to associate it with events via the
Roles tab in the Inspector:
1. Click on an event to select it.
2. In the Inspector, click on the Roles tab.
3. Create a relationship between the selected event and your entity by:
• For roles that allow a single entity only per event, select your entity
from the dropdown menu.
• Otherwise, click on the green + symbol and select your entity from
the dropdown list.
If you want Aeon Timeline to calculate a person’s age for you, give them a birth date
or birth event when creating the entity, or add it later by clicking on the Manage
Entities toolbar icon !

.

The Roles tab on the Inspector.
The Person entities “Heathcliff ” and “Mr Earnshaw” have been associated with
the current selected event.
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Divide your event into groups
Now that you have events associated with entities, you can use those relationships
to divide your timeline display into multiple groups.
Click on the Group by toolbar icon !
and select a type you wish to group by (e.g.
Person). In your timeline view, you will have a separate group for each entity, and
events will be divided according to the relationships you have created.
Note that events may appear in multiple groups if they have relationships with
multiple entities (e.g. if two different people are associated with an event). An
additional group is added at the bottom to hold any events that are associated with
none of the groups (e.g. an event that has no people allocated to it yet).

A timeline with its events grouped by Person
The age of each person along the timeline is shown at the start of each group.

Where to next?
The basics we have covered here are often enough for new users to get started
using Aeon Timeline. For some users with small and simple timelines, this may be all
they ever need.
There are a lot of advanced features within Aeon Timeline that you may want to
explore down the track, but it is often best to let it evolve naturally – wait until you
feel like your timeline is getting too complex or cluttered, or you feel like you need a
particular feature, before you seek it out.
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A few areas you may want to review as your timeline develops are:
• Navigation options to help you move around and find content within your
timeline as it grows
• Look at Timeline Settings to edit the timeline template
• Look at Display Settings to change the appearance of the timeline
• Event dependencies, if you want to tie event dates together
• Nested events, if you want to be able to show or hide more detailed
timeline events as you change zoom.
• Filters, if you want to be able to focus on a subset of your overall timeline
• Importing, exporting, and syncing, if you want to exchange timeline data
with other applications
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Notifications and Suggestions
When you first start using a timeline template, Aeon Timeline will provide you with
helpful suggestions on the best way to get started. These are provided in the
Notifications window, which can accessed via the !

symbol on the toolbar.

The Notifications Window

When you open the Notifications window you will see a list of suggestions on what to
try next.
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Steps on how to complete a suggestion

Click on the suggestion to read more information and detailed steps about how to
complete the task. Suggestions will be ticked when completed. Once all tasks are
completed you can clear the list.
If you already know how to use Aeon Timeline, or decide that you do not want to
complete certain tasks, you can delete them from the suggestions list. Click on
Select in the top left corner, select the tasks you want to delete, and click Delete.
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User Interface
The Main Interface: Timeline View
Components of the Aeon Timeline interface
The image below highlights the main components of the Aeon Timeline
interface, including:
Toolbar: Provides access to regularly used functionality
Timeline View: The largest area of the interface, which shows your timeline content
including events and groups for entities.
Inspector: Used to edit and view additional information and values for the selected
events.
Context Bar: A horizontal scrollbar that allows the user to navigate the timeline and
provides additional context of events surrounding the current viewing area.
Bookmarks: Shortcuts to scroll and zoom the timeline to a specific date or time.

The main components of Aeon Timeline
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Grouping Events
Click on the Group by button !
on the timeline.

on the toolbar to set how events should be grouped

You can divide events into groups based on any entity type, and change this
grouping at any time (e.g. you can choose to group by Project or Employee, Story
Arc or Character).

Manipulating events in the timeline
There are many ways you can manipulate events directly inside the timeline.
Selecting events
• Click on an event to select it (and unselect all others)
• Hold down ⌘ (Mac), Ctrl (Windows), or Shift (both) when clicking on an
event to add or remove that event from the current selection (this is used to
select multiple events)
• Click and drag a rectangle over a number of events to select all events in
that rectangle
Moving events to a new date
• Move all selected events by dragging them left or right on the timeline. A line
will show you where the events will be moved to, and a tooltip will show the
distance the events will be moved by, and if a single event is selected, the
new start date it will be set at.
• If dragging a single event, if you move it close to the x-axis location of the
start or end of another event, the event will “snap to” that location. This is
indicated by a shorter line and “Snap to XXX” displayed in the tooltip.
Changing events duration/end date
• Hold down Alt while dragging events left or right to alter their end date instead
of their start date. As with moving an event, a line will show you where the
event’s end date will be moved to, and a tooltip will show the change in
duration, and if a single event is selected, the new end date it will be set at.

Aeon Timeline User Manual

!11

!

Aeon Timeline

• If dragging a single event, if you move it close to the x-axis location of the
start or end of another event while holding down Alt, the event’s end date will
“snap to” that location. This is indicated by a shorter line and “Snap to XXX”
displayed in the tooltip.
Moving/Copying events to a new group
• If you drag an event vertically into another group, a new relationship will be
added to that event for the entity you dropped it on.
• If the entity type/role allows only a single entity per event, the event will be
removed from the old group (i.e. the drag becomes a “move”)
• If the entity type/role allows multiple entities per event, the event will be added
to the new entity without affecting the original entity (i.e. the drag becomes a
“copy”).
Moving events to a new parent
• Hold down ⌘ (Mac) or Ctrl (Windows) while dragging an event to drop it
onto a new parent event. The dragged event will become a child of the target
event.
• Hold down ⌘ (Mac) or Ctrl (Windows) while dragging an event out of a parent
to the main timeline to remove it from its parent. The dragged event becomes
a top-level event.
Measuring distance between events
• Hold down Alt+Shift to measure the distance between two events.
Showing/hiding event details
• Click on the green > arrow to show more information about an event.
• Click on the green < arrow to hide information about an event.
• Use the keyboard shortcut ⌘+Right (Mac) or Ctrl+Right (Windows) to show
event details for the selected events
• Use the keyboard shortcut ⌘+Left (Mac) or Ctrl+Left (Windows) to
hide event details for the selected events
Aeon Timeline User Manual
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Note: you can decide which event details are visible when you expand an event in
Display Settings.

Manipulating groups in the timeline
Collapse/Expand Groups
Groups can be collapsed to reduce the amount of clutter and vertical space for the
timeline. The location of events within the groups is still visible when you scroll, but
you will need to expand the group to see the event content.
• Click on the up/down arrows next to an entity name to collapse or expand a
group.
• Use the keyboard shortcut ⌘+Shift+Up (Mac) or Ctrl+Shift+Up (Windows) to
collapse all groups.
• Use the keyboard shortcut ⌘+Shift+Down (Mac)
or Ctrl+Shift+Down (Windows) to expand all groups.
Re-order Groups
• Groups can be re-ordered by clicking on the entity name and dragging it up or
down the timeline. A blue line will indicate the current drop location.
Note: The last “No XXX” group cannot be moved and will always be displayed at the
bottom.

Zooming and scrolling on the timeline
Use the following options to navigate around the timeline.
Horizontal scrolling
• Use a horizontal scrolling gesture on trackpads or mice that support horizontal
scrolling
• Hold down Shift while scrolling with a regular vertical mouse wheel to invert it
and scroll horizontally instead.
• Use the context bar to adjust the scroll position (see section on Context Bar
below).
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• Type a date into the search bar and hit Enter.
• Click on a bookmark.
Vertical scrolling
• Use a scroll gesture on a trackpad or a scroll wheel on a mouse
• Click and drag the vertical scroll bar on the right edge of the Timeline View
• Use the navigation bubbles on the right-hand edge of the Timeline View to
jump directly to a group (hover your mouse over the bubble to find the group
you are looking for).
Zooming
• Use pinch gestures to fluently zoom in and out
• Hold down ⌘+Scroll Wheel/Gesture (Mac) or Ctrl + Scroll Wheel (Windows)
• Use the zoom slider in the toolbar
• Adjust the zoom using the Context Bar (see section below).
The first two options will center the zoom operation around your current mouse
position.
Note: you can set the minimum and maximum allowed zoom in the Range section of
Timeline Settings.

Manipulating the context bar
The Context Bar acts as a tricked-up horizontal scroll bar for your timeline. The lens
highlights your current position within the timeline, while the remainder of the bar
shows you current events in your current view and the surrounding timeline.
Scrolling the timeline
• Drag the context lens to the left or right to scroll the timeline. The context bar
will automatically scroll when you get to the edge of the screen.
• After you release the context bar, it will animate back to the centre of the
screen after a short delay.
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• Alternatively, click anywhere on the context bar to scroll directly to that date.
Adjusting timeline zoom
• To adjust the zoom of the context bar, click and drag the left or right edge of
the context lens to stretch or contract it. The timeline will adjust to the zoom
level you specify when you release.
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Relationship View
A Vertical View
For the Relationship View, we have optimised our use of space by turning our usual
horizontal timeline on its side, creating a table-like view with events are listed in rows
down the left side of the view, and entities are represented as columns along the top.
Relationships between entities and events are represented with icons drawn at the
intersection between these rows and columns. Click on any intersection to set or
remove the role for that relationship.
This layout allows us to fit more events and entities on the screen with minimal visual
clutter.
Users are able to control which entities are displayed and their order, and of course
apply filters to events, so that only information of interest is displayed.

The Relationship View

Aeon Timeline User Manual

!16

!

Aeon Timeline

Incorporating date/time elements
To clean up the Relationship View, we have tossed out the usual linear time
representation of our standard Timeline View, opting instead for a sorted list
approach.
Although the linear mapping of time has gone, that date and time information is still
visible on the relationship view in several locations:
• The date and time range is listed underneath each event
• The offset between successive events is marked on the left-hand side of
the view
Both of these options can be turned off if you have no interest in the date/time
information, or want to fit the maximum number of events and entities on the screen.

The vertical alignment of events in Relationship View.
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View All or Group By Type
As with our standard Timeline View, the Relationship View still allows you to choose
whether to group events by type (e.g. group by character, place, project, employee,
etc.) or to show all events in a single list.
When displayed as a single list, the events will be listed chronologically from the
earliest event at the very top of the view to the latest event at the very bottom
When grouping events by type, each individual group will be sorted instead. As with
the Timeline View, you can collapse and expand groups so that you can concentrate
on only the views you want.

Events grouped by type in Relationship View
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How to use Relationship View
You can switch between Timeline View and Relationship View by choosing “Timeline
View” or “Relationship View” from the View menu, or by using the View Mode toolbar
icons (Mac version shown):

!

Choosing which entities to display as columns
The settings icon !
in the top-left corner of the Relationship View allows you to
select which entities are shown as columns in the Relationship View.

Changing column order
You can re-order entities within their groups by dragging them into a different order in
the Relationship View itself. You can also drag the group names at the top to reorder the groups themselves.

Choosing which entities are show as columns in the
Relationship View
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Choosing icons for types and roles
You can now choose your own custom icons for Entity Types and Roles via Timeline
Settings. The chosen role icon will be used to mark relationships at intersections in
the Relationship View.

Choosing an icon to use in Relationship View
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Changing relationship between Events and Entities
Click on the intersection between any event and entity to configure the relationship
between those items.
When you click on an intersection, a dropdown menu will allow you to choose which
Role you want the Entity to perform for the given Event. Available roles, and the
icons used for those roles, are configured via Timeline Settings.
You can of course continue to edit relationships via the Inspector also.

Choosing the relationship between an entity and an event

Entity Ages
When Event Dates are configured to be shown in Display Settings, the Relationship
View will also show the age of an entity for each relationship (provided such ages
can be calculated).
To conserve space, ages are not shown when event dates are turned off, but you
can still find out a character’s age by hovering your mouse over the relationship icon.

Parent/Child Events
Relationship View provides two options when showing parent/child events:
• Tree View: Child events are nested under parents in an expandable tree
structure, allowing you to see more or less information as required. As child
events are shown underneath their parent, they are internally sorted, but
cannot be sorted relative to other events.
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• Flattened List: All events are shown in a single flattened list, allowing you to
view all events in chronological order, including events that belong under
different parents.

Parent and child events displayed in Tree View

You can use the button group shown on the Relationship View to toggle between
these two options:
!

Toggle Offsets
If you are working on a smaller screen, you can remove the offsets from the left-hand
side of the view by clicking on the Show/hide offsets button:

!
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Relationship view with the offsets turned off
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The Inspector
Editing Selected Events
You can open or close the Inspector by clicking on the Inspector icon !
toolbar.

on the

You can use the Inspector to update all fields, values and relationships for the
selected event.
The Inspector allows you to edit values for multiple selected events at the same time:
• When multiple events are selected, the Inspector will show any values or
relationships that are common for all selected events.
• Values that differ between selected events will be shown as blank.
• You can still edit those events, in which case all events will be set to the
new value that you enter.

Selecting multiple events
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Basic Event Details
The top section of the Inspector shows the following information:
Selected Event IDs: This shows the IDs of all selected events. Clicking on an ID will
scroll that event into view on the timeline.
Event Title: The title of the selected events.
Color: The color of the selected events.
Parent: The parent event of the selected events (see Nested Events).

The basic event details show at the top of the Inspector

Range Tab
The range tab allows you to specify the start, duration, and end for an event.
Internally, Aeon Timeline records events Start Dates and Duration, with the End Date
calculated from those two values. This allows an event to retain the same duration
as it is dragged around the timeline.
If you enter an end date, Aeon Timeline will calculate the necessary duration for the
event to stretch from the start date to your entered end date, and will then store this
value internally.
Subsequently changing the start date will cause the end date to be recalculated.
Using the Date Picker
Aeon Timeline uses a flexible date picker control that allows you to type dates in
many different formats and with a range of precisions, such as:
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• 2012 (year-only)
• 2012 BC (year-only, different era)
• March 2012 (month+year only)
• 23 March 2012 (date, long format)
• 23/3/2012, 3/23/2012, 2012-3-23 (date, various short formats)
• 23 March 2012 2:30pm (date and time, minute precision)
• 23 March 2012 14:30 (date and time, 24-hour format)
• 23 March 2012 14:30:27 (date and time, second precision)
You can also click on the calendar icon to view a popover calendar display to select
a date.

The Date Picker
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Using the Duration Control
For date based timelines, enter your preferred duration as a value followed by a unit.
Possible unit values are years, months, weeks, days, hours,
minutes, and seconds (e.g. “2 years” or “15 weeks”).
Combinations of units is also allowed (e.g. “2 years 3 months”).
You can type y, m, w, d, h, mi, s as a shorthand and the Duration Picker will
automatically complete the rest of the unit.
Event Precision
The precision for an event will be determined by the maximum precision of the start
date and duration that you enter.
For instance, if you enter a start date of 2012 and a duration of 3 years, Aeon
Timeline will only display year information on the timeline (i.e. 2012-2014).
Conversely, if you enter 2012 and 2 months, the event precision is now months, and
a date value of January – February 2012 will be shown instead.
Dependencies
The range tab also shows you information about any dependencies associated with
an event.
The Based on list shows any dependencies that are used to calculate the selected
event’s start date. You can add further dependencies by clicking on the add (+) icon,
or edit the existing dependencies by clicking on the edit icon. If you wish to delete a
dependency, click on the edit icon and then click on the Remove button in the
ensuing popover.
The Successors list is a read-only list that shows any events whose start date is
calculated from the selected event.
In either case, clicking on the title or a predecessor or successor event will scroll the
timeline to that event and select it (the Inspector will then change t o showing
values for the newly selected event).
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The dependencies of an event in the Inspector

Values Tab
Tags
The tags field allows you to add and delete tags from the selected events. Existing
tags will be suggested to you as you begin to type.
If you need to edit the value of a tag globally wherever it appears, use the Manage
Tags dialog.
Property Values
The remainder of the tab allows you to set any other property values for the selected
events.
Available properties for events depends on your chosen template, and can be
changed via Timeline Settings.
The type of the property determines how the property is displayed in the timeline:
• Single-line Text fields are displayed as a single line text input
• Multi-line Text properties are shown as a multi-line text area
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• Yes/No properties are shown as a checkbox
• Numeric (Integer, Decimal, Currency and Percentage) properties are
displayed as a number text field.
• List of options properties are shown as a drop down list.

The Values Tab

Roles Tab
The Roles tab allows you to configure relationships between events and entities.
This is done by choosing which events are responsible for particular roles within an
event.
Each entity type (e.g. Person, Project, Location, Story Arc) is able to perform one or
more roles for an event (e.g. a Person can be a Participant in an event, or a
Witness). The available entity types and roles for events depends on your chosen
template, and can be changed via Timeline Settings.
If a role is configured to allow only a single entity per event, it will be shown in this
tab as a drop-down list. In such cases, you can select a single entity from the
dropdown to perform that role, or select None if you want that role to be vacant.
If a role is configured to allow multiple entities per event, it will be shown in this tab
as a list. In such cases, you can:
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• Click on the + icon and select an entity name to create a new relationship
(if you have a lot of entities, you can type the first few characters of the
entity into the search box to narrow down the options).
• Click the + icon and type a brand new name to create a relationship to a
brand new entity with that name
• Click the – icon to remove an existing relationship.
If an entity has a birth date or birth event, Aeon Timeline will automatically calculate
the age for the entity at the selected event and show it underneath the entity name in
the list.

The Roles tab
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Links Tab

The external links tab

Events can have links with images and documents on the local computer, a network
drive, or over the internet. These are added as “Links” in the Links tab.
Events can also have images and documents embedded in the timeline file. These
are added as “Attachments” in the Links tab.
You can also add an image as a specific type of attachment under the “Image”
heading. This will display the image in the inspector, and if the timeline is configured
to show images, it will be shown on the timeline when the event is expanded (the
green arrow is clicked).
In this tab, you can:
• Add new links/attachments by clicking on the + symbol, and then either
typing a title and URL/path for the file, or by clicking on the Browse button
and selecting a file.
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• Edit existing links by clicking on the edit icon and then changing link
details.
• Remove existing links by clicking on the edit icon and then clicking
Remove.
• Remove attachments and images by clicking the minus symbol.
The icons underneath each link allow you to perform the following additional actions:
• Mac-only: View it inside Aeon Timeline using its Quicklook plugin
• Reveal the link in Finder (Mac) or Windows Explorer (Windows)
• Open the file in its default application
Under the Sync heading, it will show any Scrivener documents that are linked to the
selected event.

Navigating the Timeline
Zoom
Aeon Timeline allows you to zoom in and out of your timeline to the time scale you
wish to see: anything from billions of years to individual minutes and seconds.
You can set the minimum and maximum zoom levels allowed for your timeline via
Timeline Settings, and fluently zoom in and out using pinch gestures, ⌘ + scroll
wheel/gesture (Mac), Ctrl + scroll wheel (Windows), or by adjusting the zoom slider
on the toolbar.

Setting the zoom limits
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Bookmarks
For timelines that cover large time periods with several key moments interspersed
throughout, bookmarks allow you to quickly jump between different time periods. If
you have a particular time you want to bookmark, scroll to that time period, zoom to
your desired time scale, and then add a bookmark for that location.
Each time you click on the bookmark, your timeline will zoom and scroll back to your
desired setup.

Bookmarks on the timeline
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Search
Activate the search bar by hitting ⌘F (Mac) or Ctrl+F (Windows), type a search term
and hit enter to select the next event that matches your search and scroll it into view.
You can jump between multiple matching selections using Find Next and Find
Previous.
For fast navigation to any point in time, simply type a date into your search field to
scroll your timeline directly to that date.

Searching for events

Context Bar
The Context Bar acts as a tricked-up horizontal scroll bar for your timeline. The lens
highlights your current position within the timeline, while the remainder of the bar
shows you current events in your current view and the surrounding timeline.
Drag the lens to scroll the timeline, or click on any other location on the Context Bar
to jump directly to that date. You can also adjust your zoom by resizing the lens from
its left or right edge.

The Context Bar
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Scroll To Group
With events divided into groups based on your chosen Entity Type, it is important to
be able to navigate quickly between groups. Rather than scrolling vertically to hunt
down your desired group, you can use the navigation bubbles on the right-hand edge
of the screen to quickly jump between groups.
Hover your mouse over each bubble to see the Entity Name associated with each
group, and click on the bubble to scroll your timeline to the top of that group.

The timeline grouped by Entity Type. The bubbles on the right can be
used to quickly jump between groups.
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Display Settings

The Display Settings window

Skin
Different themes for your timeline.

Size
Different zoom levels for the entire user interface rather than just the timeline.

Scrolling

• Do not constrain scrolling – Scrolling left and right is unlimited and
unbounded
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• Bounce once at first/last event, then continue – Scrolling left and right
will stop at the first and last events, but still allows the ability to continue
• Restrict scrolling to first/last event – Scrolling can be done up until the
first and last event.

Layout
• Use minimum space possible
• Events will be displayed at the top-most vertical space that will fit
them.
• This uses the least space, but events are interleaved and related
events may be separated vertically by others
• Event positions are inconsistent when zooming (they are likely to
shuffle around to very different vertical locations when you change
the zoom)
• Cascade unbroken groups from top
• Each event will be displayed underneath the previous one, until there
is enough room to return to the top and have all later events
displayed in an unbroken chain.
• This avoids interleaving events, and uses much less space than the
last option (but more than the first)
• Event positions are inconsistent when zooming (they are likely to
shuffle around to very different vertical locations when you change
the zoom)
• Only return to top when clear of all previous
• Each event will be displayed underneath the previous one, until an
event’s start position is further right than the right-most edge of all
previous events.
• This is more stable and consistent when zooming (events won’t jump
around so much), but can create very long chains (and a lot of
vertical height) for large timelines.
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Options
• Show event IDs on timeline – The event ID is shown on individual
events:

!

• Show event dates – The date of the event is shown on individual events:
!
• Indicate Today - shows a vertical line on the timeline that marks the
current date. This line will update in realtime.
• Show duration in title - if the event has a duration greater than 0, then it
will displayed in the title of the event.
Display Contents
These items are the layout template of you expanded events. You can drag in and
out different properties of your events. To add and remove items, drag-in and dragout respectively. To move items, drag an item on to another to swap positions.

An expanded event. The details that are displayed when you
expand an event can be determined in the Display Settings
window
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Dates and Calendars
Representing Dates and Durations
How End Dates are Calculated
Internally, Aeon Timeline records events Start Dates and Duration, with the End Date
calculated from those two values. This allows an event to retain the same duration
as it is dragged around the timeline.
If you enter an end date, Aeon Timeline will calculate the necessary duration for the
event to stretch from the start date to your entered end date, and will then store this
value internally.
Subsequently changing the start date will cause the end date to be recalculated.

Event Precision
Some events may be precise to a given year only, while others specify a date and
time down to the exact second. There are several reasons you may want to do this:
• An event may be a historic event where the exact date or time is unknown,
only an approximate value such as a year.
• An event may take place over an entire day, week, month, or year, so
specifying more precise time doesn’t make sense.
• A fiction writer may not need precision down to exact dates/times, in which
case making up these values is an unnecessary distraction and clutters up
the timeline with unnecessary information.
Aeon Timeline allows you to specify varying levels of precision for each event, so
you can mix and match events that are specified to the second with events that only
contain a year.

How event precision is calculated
The precision for an event will be determined by the maximum precision of the start
date and duration that you enter.
For instance, if you enter a start date of 2012 and a duration of 3 years, Aeon
Timeline will only display year information on the timeline (i.e. 2012-2014).
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Conversely, if you enter 2012 and 2 months, the event precision is now months, and
a date value of January – February 2012 will be shown instead.

How imprecise events are displayed
Although more precise date information is not displayed on the timeline, the event
still must be positioned on the timeline relative to other events. Aeon Timeline uses
the following rules to determine where an event should be displayed:
Start Dates
• If time is not specified, default to the beginning of the specified day
(represented as 00:00:00).
• If the day of the month is not specified, default to the beginning of the
month.
• If the month is not specified, default to the beginning of the year.
End Dates
• If the time is not specified, default to the end of the day (represented as
24:00:00, see below)
• If the day of the month is not specified, default to the end of the month.
• If the month is not specified, default to the end of the year.

Representing End Dates and Midnight
There is an ambiguity in the way we naturally talk about dates, and a precise
mathematical representation of the dates themselves.
A brief example
Let’s assume we have an event that starts in January and lasts for 3 months.
Mathematically, this would mean a start date of “2016-01-01 00:00:00” and an end
date of “2016-04-01 00:00:00”.
But for most people, a natural interpretation of this would be January – March 2014
(i.e. it lasts for 3 months, and those 3 months are January, February, and March).
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This is because we typically refer to end dates inclusively, at least for precisions of
days or larger.
How Aeon Timeline represents end dates
Aeon Timeline mirrors this natural approach when talking about dates – the end date
is always considered to be inclusive.
So an event that starts in April and lasts a year goes from April 2016 – March 2017
and not April 2016 – April 2017.
To ensure consistency and avoid confusion throughout the application, we extend
this policy for all precisions throughout our interface. Thus, the same example at
varying precisions would be:
• 2015 – 2016
• January 2015 – December 2016
• 1 January 2015 – 31 December 2016
• 1 January 2015 00:00:00 – 31 December 2016 24:00:00
As can be seen, we represent the end time as 24:00:00 instead of the
mathematically identical 1 January 2017 00:00:00.
The use of 24:00:00 is a less common but legal representation of a date, and is
necessary to deliver consistent handling of dates at all precisions.

Absolute and Relative Timeline Styles
Most timelines will use absolute dates, meaning that you specify an exact date or
year for each event on your timeline.
However, Aeon Timeline supports several other timeline “styles” that allow you to
specify times relative to a theoretical “zero”. Uses for such relative timelines include:
• Planning a fiction story without needing to think about specific dates and
times
• Planning a project or development schedule based on weeks before you
know a definite kick off date.
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• Planning a seminar or training workshop that you will repeat many different
times.
• Planning screen or stage time in a movie, where you want to map out
scene times over a period of several hours.

Setting the Timeline Style
The timeline style is set in the Range -> Date section of Timeline Settings, and can
be set to the following values:
Regular Dates: Dates are represented in the normal way as absolute values (a
specific day/month/year)
Weekly: Weeks count forward from zero, i.e. Week 0, Week 1, Week 2. Events can
be specified as occurring on a specific day or time during that week – e.g. “10:00
Monday Week 6”.
Daily: Days count forward from zero, i.e. Day 0, Day 1, Day 2. Events can be
specified as occurring at a specific time during that day – e.g. “10:00 Day 3”.
Time: Time counting forwards or backwards from zero, e.g. 02:32:34 or -12:45:00.

Setting the “Zero Date”
When changing from regular dates to any of the weekly formats, or vice versa, you
will be asked to specify the date to be used as “zero” in your conversion. All existing
dates in your timeline will be converted based on their relative offset from this zero
date.
For instance, if you convert from Regular Dates to Daily using a zero date of “1 Jan
2016”, existing dates would be converted as follows:
• 1 Jan 2016 becomes “Day 0”.
• 3 Jan 2016 becomes “Day 2”.
• 5 Jan 2016 12:00pm becomes “Day 4, 12:00pm”
• 3-7 Jan 2016 becomes Day 2-6.
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Custom/Fantasy Calendars
What Are Custom Calendars?
By default, Aeon Timeline ships with an implementation of our standard Western
Gregorian calendar, with 12 months in a year, 7 days in a week, and eras marked as
BC and AD.
Aeon Timeline allows users to create their own custom calendars for use in projects.
Uses for this include:
• Changing the names of existing elements (e.g. using BCE and CE, or
renaming weekdays and months to another language)
• Re-creating other historic calendars such as the Julian calendar.
• Creating your own fantasy calendar with your own fantasy world.

Editing Calendars
Calendars are created and edited as part of Timeline Settings. Once you have
created your calendar, you can choose Save as Custom Template in Timeline
Settings to save the edited template (including your calendar) as a new custom
template option. It will then be available to choose for new projects in the Welcome
screen.
Note that calendars can only be edited for new timelines. Once you add an event or
entity to a timeline, you will no longer be able to edit the calendar.

The Edit Calendar window
Aeon Timeline User Manual

!43

!

Aeon Timeline

Components of a Calendar
When designing a custom calendar, it is composed of the same elements that are
used in a standard calendar. As such, a calendar has the following components:
Era
An era represents a block of years numbering from 1 to a maximum value. Eras can
count forwards or backwards (starting from 1), and usually last for a specific number
of years.
In all calendar systems, there must be one backwards era of infinite length, and one
forwards era of infinite length (equivalent to our BC and AD) , so that any point in
time can be correctly labelled. In some calendar systems these may represent prehistoric times and unknown future times.
Eras can be set to include “leap years”. These are calculated using the rules of our
standard Western calendar (every 4th year except every 100th, but including every
400th).
Years
Normally, this is used to represent the number of days for a planet to orbit the sun.
However, in more general terms, this represents a number of days that are grouped
together.
A year is composed of a number of months. You cannot set the duration of years
directly, instead the duration of a year is determined by the sum of the days in all
months.
Months
A month is given a name (such as January), an abbreviated name (such as Jan),
and a length in days for both normal and leap years.
In the standard calendar, months approximate the length of a lunar cycle, but in a
custom calendar they could be used for other purposes, such as setting up a
different month for each “season”.
Although all calendars must contain at least one month, you can setup a single
month that lasts the duration of a year and effectively ignore the value, if desired.
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Days
In the standard calendar, a day represents the amount of time it takes for the Earth
to rotate on its Axis (approximating the length of time between sunsets).
In creating a custom calendar, you can specify the number of hours in a day.
You can also specify the number of days in a week, and give a name (such as
Monday) and abbreviated name (such as Mon) to each day.
To link your days with the rest of the calendar system, one day must be specified as
the first day of the final era (this is the equivalent of specifying that the 01/01/0001
AD is a Monday).
All custom calendars must have at least one day, but if you do not wish to have
separate weekdays, you can create a single weekday (called ‘Day’), and effectively
ignore the value.
Hours, Minutes, Seconds
As mentioned above, the custom calendar allows you to specify the number of hours
in a day.
Aeon Timeline does not allow you to customise units smaller than this. An hour will
always be composed of 60 minutes, and a minute will always be composed of 60
seconds.
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Advanced Topics
Dependencies
What are Dependencies?
Dependencies allow you to calculate the date of an event based on an offset from
the start or end of another event (e.g. Event B = end of Event A + 10 days). This ties
the two events together in time so that when you move one event, the other will
automatically follow. An event can have multiple dependencies, in which case its
start date will be set to the latest calculated date.
Dependencies allow you to ensure pre-requisites are met in a project (i.e. a task that
cannot start until an earlier one has completed), or tie together events in a fiction
story that require a fixed offset (e.g. a birth must occur 9 months after conception).

Dependencies on a timeline. Event 4 is dependent on
Event 3 and Event 3 is dependent on Event 2

Configuring Dependencies in the Inspector
Dependencies are configured in the Range tab of the Inspector. You can view, edit
and remove existing dependencies for each event in the Based On list.
To add a new dependency, click on the green + symbol, and in the Add Predecessor
popover, select the event, offset, and whether the offset should be added to the start
or end of the event.
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In the Range tab, click on the green + symbol
to add a new dependency

The Add Predecessor popover

Edit and Delete Dependencies
To edit an existing dependency, click on the edit symbol next to the event (square
with pencil), update the values and click OK.

To Edit/Delete dependencies, click on the edit
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To remove an existing dependency, click on the edit symbol next to the event, and
then click on the Delete button in the ensuing popover.

Shortcut to Add Dependencies
You can quickly add dependencies between selected events by choosing Make
Dependent from the Timeline menu or the right-click context menu.
If two events are selected, a new dependency will be created as follows:
• The second event will be made dependent on the first event (as
determined by their current dates)
• The new dependency will use the existing offset between the events, so
that neither event will change dates when the dependency is created.
• If the second event occurs after the end of the first event, the
dependency will use an offset from the end of the first event.
• Otherwise, it will use an offset from the start of the first event.
If more than two events are selected, a chain of dependencies will be created, such
that the second is dependent on the first, the third is dependent on the second, and
so on.
If you want to quickly create dependencies with 0 offsets from the end of events, you
should first choose Make Consecutive from the menu before choosing Make
Dependent.
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Nested Events
What are Nested Events?
Aeon Timeline allows you to nest child events inside parent events so you can break
down a task into a number of smaller tasks, or group many related events into a
single parent.
When you zoom in, you can choose to expand your parent events to see the
individual child events. As you zoom out, expanded parents will automatically
collapse, allowing you to see the parent event within the broader context without
cluttering your timeline with a lot of unnecessary detail for that zoom level.
Events can be nested many levels deep, allowing you to zoom from a War to a Battle
to the timing of events within that battle without affecting your ability to view the
overall context when required.

Nested Events

How Parent Event Ranges are Calculated
The range of a parent event (i.e. its start and end dates) are calculated entirely from
the ranges of its child events, as follows:
• The start date for a parent event is equal to the earliest start date of its
child events.
• The end date for a parent event is equal to the latest end date of its child
events.
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• The duration of a parent event is calculated from the above start and end
dates.

Moving parents and all children
To move a parent event and all of its children to a new date, you can drag the parent
to a new location in the timeline or change the parent’s start date in the Inspector.
When moving a parent event in this way, all of its children (and consequently,
grandchildren) will be moved by the same amount to keep the same relative offsets
between all affected events.

Dragging a parent event to a new date. This will move all the children of the
event by the same relative offset.

Adjusting parent without affecting all children
If you wish to extend or contract the range of a parent event without affecting its
children, you will need to add, remove or modify individual child events to get the
parent range that you want.

Changing an Event’s Parent
You can assign a parent to an event in a number of ways:
• When creating the event, select your preferred Parent from the dropdown
list. If you choose (No Parent), the event will be created as a top-level
event.
• Inside the Inspector, modify the Parent field (as pictured below).
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• Hold down the Ctrl key on Windows or the Cmd key on Mac and drag
your desired child event on top of the intended parent event. You can also
hold down Ctrl/Cmd and drag an event out of its parent to make it a toplevel event.

In the Inspector, you can modify the Parent of an
event with the Parent field

Preserving Newly Created Parent’s Ranges
If any of the above actions will add the first child to an event, thus making it a parent
for the first time, you will have an additional decision to make.
As described in How parent event ranges are calculated above, a parent event’s
dates are entirely decided by their child events. This means that in the normal course
of making an event a parent, its existing range (i.e. start and end date) will be lost
and replaced by the range of its child events.
If you are building your timeline from the top down (i.e. you have created high level
events and are now filling in the detail), this may be undesirable as the parent event
may already be carefully positioned (e.g. you have created an event for World War 2
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from 1939-1945, and are now wanting to add some key child events within that
parent).
Aeon Timeline will prompt you when adding the first child to a parent whether you
want to create additional new child events to mark the original start and end of your
event:
• If you click No, your original parent’s range will be entirely replaced by the
range of its new children.
• If you click Yes:
• A new event called “Start of XXX” will be added at the original starting
location of the parent event.
• If the parent event has a duration greater than zero, an additional
“End of XXX” will be added at the original end location of the parent
event.
• The children will then be added to the event, and the parent’s range
calculated as normal from all of its children.
There is nothing special about these newly created events. They only represent the
original start/end location of the parent and are not
tied to the parent event’s
start: if you add a child event earlier than the original range, the “start of XXX” event
may no longer be at the start of your parent.
You can move them, rename them and delete them just like any other event.

You can create start and event child events which will preserve the current start
and end positions of an event
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Embed in New Parent Event
As an alternative to the above, choose Embed in new parent from the Timeline
menu or the right-click context menu. This will prompt you to create a new parent
event, and then move all of the selected events underneath this newly created event.
This can be useful if you are coming at your timeline the other way and building it
from the bottom-up rather than top-down.
Note: when choosing this option, the Parent field in the dialog to create the event
specifies the parent of your newly created event (in effect, the grandparent of your
selected events).

Embed an event in a new parent event
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Filters
As your timeline gets more cluttered and complex, it can be useful to reduce the
visible events down to ones you are interested in at the time. Aeon Timeline contains
a very powerful and flexible filtering system, allowing you to filter events based on
their dates and durations, tags, individual properties, and their relationships with
entities such as people, projects or story arcs.
Multiple filter elements can be combined together using AND or OR to create
complex filters, which can be saved and reloaded to give you quick access to any
common filter you wish to create.

How to Apply a Filter
Turn on filtering
To turn on filtering, press the filter toolbar icon !
top of the timeline view.

. The filter bar will slide down at the

The first time you open the filter bar, it will be empty. Click where it says Click to add
filter… to add your first filter condition.
Adding to your current filter
Each filter condition is composed of a Field, which you can select from a dropdown
list containing items such as entity, date, title, and color, and a Value. Optionally, you
can choose to include those events that do NOT match a certain criteria. Once you
have entered the field and value, hit Enter or press the !
filter with your chosen values.

button to create a new

Once the filter is applied, only events whose field matches the value specified will be
shown on the timeline.
If you wish to add further conditions to your filter to create a more complex set of
rules, you can again click on the Click to add filter… text to add a second filter
condition. When adding each subsequent condition, you can choose whether to use
AND (match both) or OR (match either) logic in combining the filters.
Removing filter conditions
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Individual filter items can be removed by clicking on the x icon inside the filter
condition.
Alternatively, you can clear the entire filter to start again by clicking on the !
on the far right of the filter bar.

button

Turn off filtering
You can turn off filtering by clicking on the filter toolbar icon !
to hide the filter bar.
When filtering is turned off (the filter bar is hidden), no filters will be applied to your
events.
Aeon Timeline remembers the last filter conditions when you close the filter bar, and
those same conditions will be applied the next time you turn filtering on.

Adding a Filter

Saving and Loading Filters
Aeon Timeline allows you to save frequently used filters so that you can quickly
apply them without having to reconstruct them each time.
To save a filter, click on the ! button on the left hand side of the filter bar, and
choose Save. You will be asked to enter a name for your filter.

Saving a Filter
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When you want to use the filter later, click on the !
choose the name of the filter you wish to use.
To delete a saved filter, click on the !
name of the filter to delete.

button, click on Load, and then

button, click on Delete, and then choose the

Accepted Fields and Values in a Filter
The full list of possible filter items and their associated possible values is listed
below. In each case, the field name is provided in bold, and the values listed
afterwards.

Title
Field Name: Title
Possible Values: Any text string typed by the user.
The condition will match any event that contains that text somewhere in the title (e.g.
“Title: Bob” will match “Bob goes for a walk” and “Fred and Bob drive to freedom”).

Range (e.g. Date)
Field Name: name of the Range property in timeline settings (usually “Date”)
Possible Values:
• Exact Values
• “2012”: Matches any event that overlaps with part of the year 2012.
• “March 2012”: Matches any event that overlaps with part of March
2012.
• Comparison Values
• “>= 2012”: Matches any event that ends after 1/1/2012 00:00:00.
• “> 2012”: Matches any event that ends on or after 1/1/2013 00:00:00.
• “<= 2012”: Matches any event that starts before 1/1/2013 00:00:00.
• “< 2012”: Matches any event that starts before 1/1/2012 00:00:00.
• “before 2012”: Same as < 2012.
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• “after 2012”: Same as > 2012.

Color
Field Name: Color
Possible Values: Any color defined in Timeline Settings, chosen from a list.

Tag
Field Name: Tag
Possible Values: Any tag added to the timeline, chosen from a list.

Entities/Relationships
Field Names:
• The word: “Entity”
• The name of any Entity Type (e.g. Person, Character, Project, Story Arc)
• The name of any Role (e.g. Participant, Witness)
Possible Values:
• The name of any matching entity, chosen from a list.
• “None”
When using “Entity” or an Entity Type name as the field, the filter will match any
event that has a relationship with that entity.
When using the Role name as the field, the filter will only match events that have
relationships with that entity in the specified Role.
If you specify a value of “None”, the filter will match events that do not have any
relationships for the specific entity type or role.

String Properties
Field Name: The name of any Property in timeline settings that is set to type “Singleline Text” or “Multi-line Text”
Possible Values: Any text string typed by the user.
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The condition will match any event that contains that text somewhere in the property
value.

Yes/No Properties
Field Name: The name of any Property in timeline settings that is set to type “Yes/
No”.
Possible Values: Yes, No.

List of Options Properties
Field Name: The name of any Property in timeline settings that is set to type “List of
options”.
Possible Values:
• The name of any of the defined options, chosen from a list.
• “None”

How Filters are Combined: A Lesson in Boolean Logic
Logical NOT
Every time you add a filter item, a dropdown options lets you choose whether to
match an item that HAS a certain criteria, or one that does NOT have that criteria.
When NOT is selected, the effect of the filter is reversed… events that do not match
the criteria will be shown, while events that do match the criteria will be hidden.
Logical AND and OR
When combining multiple filters, you choose whether to join each new filter with
the AND or OR logical operator.
When combining two filters using AND (e.g. Color: Red AND Date: > 2015), events
will only be included if both of the criteria are true. The above example will match a
Red event in the year 2017, but not a Green event in the year 2017, nor a Red event
in the year 2013.
When combining two filters using OR (e.g. Color: Red OR Date: > 2015), events will
be included if either of the criteria are true. The above example will match a Red
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event in the year 2017, a Green event in the year 2017, and a Red event in the year
2013.
Order of Operations
Much like regular mathematics where multiplication and division take precedence
over addition and subtraction, boolean algebra also has an order of operations.
In boolean algebra, AND take precedence over OR, which is important when
combining more than two filter conditions together.
This means that the filter: A OR B AND C
is evaluated as: A OR (B AND C)
and therefore, your intended effect is: (A OR B) AND C
you will need to enter the longer form: A AND C OR B AND C
To provide a concrete example, let’s assume we have events with the following
properties:
1. “Walk the dog”, Red, 2015
2. “Play fetch with the dog”, Green, 2016
3. “Build the dog a kennel”, Red, 2016
4. “Be ignored by the cat”, Blue, 2012
The following filter will match events 1, 2 and 3:
Color: Red OR Title: Dog AND Date: 2016
Whereas this filter will match only events 2 and 3 (not 1):
Color:Red AND Date: 2016 OR Title: Dog AND Date: 2016Attachments and
Images
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Attachments and Images
What are Attachments?
Events can have attachments associated with them. These are files that you can add
from your local computer that are copied into the timeline file. This will increase the
size of your timeline file, however they will always be available in your timeline, even
if the files change location.

Attachments and Images

In the Links tab on the Inspector, under the Attachments heading you can:
• Add new attachments by clicking on the + symbol, browsing and selecting
a file
• Remove existing attachments by clicking on the - symbol.
The icons underneath each attachment allow you to perform the following additional
actions:
• Mac-only: View it inside Aeon Timeline using its Quicklook plugin
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• Open the file in its default application
When you attach a file, you are taking a copy of the file at that point in time. Any
changes you make to the original file will not be reflected in the attachment. You
would need to delete the attachment and add the updated file as a new attachment.
The maximum allowed attachment size is 50MB. For larger files, you should use
External Links.

What are Images?
Images are a special type of attachment. If your file is a PNG, JPG, GIF or BMP, and
you want it displayed as part of the timeline itself, set is as the event’s image.
The image will then be displayed when you expand the event, and also in the
inspector.
Images work the same as attachments in that they are copied into the timeline file.
Therefore they will increase the size of your timeline file, however they will always be
available in your timeline even if the files change location.
You can only have on image per event. If you have multiple images you want
associated with an event, you will need to add them as attachments.
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External Links
Events can have links with images and documents on the local computer, a network
drive, or over the internet.
In the Links tab in the Inspector you can:
• Add new links by clicking on the + symbol, and then either typing a title
and URL/path for the file, or by clicking on the Browse button and selecting
a file.
• Edit existing links by clicking on the edit icon and then changing link
details.
• Remove existing links by clicking on the edit icon and then clicking
Remove.
The icons underneath each link allow you to perform the following additional actions:
• Mac-only: View it inside Aeon Timeline using its Quicklook plugin
• Reveal the link in Finder (Mac) or Windows Explorer (Windows)
• Open the file in its default application

The External Links Tab

How External Links are Maintained
Unlike some file package formats including Scrivener Projects and Microsoft Word,
Aeon Timeline does not make a copy of linked resources inside the Aeon Timeline
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file. Instead, it maintains a link to the document’s external location on the file system.
(If you wish to make a copy of a linked resource, consider using Attachments
instead of External Links)
There are several benefits to this approach, the most critical of which being the
following:
• Aeon Timeline can retain a light and portable file format that won’t come
too large
• As documents are not copied, Aeon Timeline will always be able to link to
the most recent version of the file where an internally copied document
would “go stale”.
The downside to this approach is that the user may move or delete events in their file
system, which may in turn lead to broken links (documents that cannot be found by
Aeon Timeline).
To counteract this, Aeon Timeline keeps track of linked files using two distinct
approaches:
Relative Path: Aeon Timeline records the relative path from where the timeline file is
stored to where the externally linked file is stored, and looks for a document with the
same name at the same relative path. This allows Aeon Timeline to find the correct
file if an entire folder system is moved or copied (if copied onto a USB key or synced
to another computer using Dropbox, for example).
Absolute Path: Aeon Timeline also records the absolute path of a linked document.
This means that timeline documents can be moved around a computer
independently of linked files and the links will still be retained.
Each time a timeline file is opened, Aeon Timeline attempts to locate all of the
externally linked documents using the above techniques in the above order. Once a
document has been found using one of the methods, the information for the other
methods is then updated to reflect the position of the newly found file.

Moving Timelines and Linked Files Between Computers
If you anticipate the need to use your timeline file on multiple computers, the best
approach is to keep your timeline file and externally linked documents in a single,
consistent folder structure across all machines.
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As an example, if you save both the timeline and linked images into a single folder,
you can copy that folder onto a USB stick, and then onto another computer, and
Aeon Timeline will be able to maintain the link to the external file using the same
relative path regardless of where you copy the folder.
More complex folder structures will work equally well, provided the entire folder
structure is duplicated across all machines.
Warning: If you are not copying the entire folder structure at once, be careful about
opening the timeline file while it is copied onto a USB stick. It will first attempt to
resolve the links using the relative path, but if it cannot find them, it will revert to
using the absolute path to find the files in their original location on the computer.
Once the external links are resolved using this method, the relative path would be
updated to match that absolute path, and the links will be broken when the USB
device is connected to a new computer.
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External Links vs. Attachments
Aeon Timeline allows two ways for events to reference files, External Links and
Attachments. External Links refer back to the file on your computer, while
Attachments take a copy of the file and embed it in the timeline.
It’s up to you which one you use to reference your documents, however if you are
unsure here are a couple of things to consider:
• When you attach a file, you are taking a copy of the file at that point in
time. Any changes you make to the original file will not be reflected in the
attachment. If your file is something that is constantly changing, consider
adding it as a Link.
• The maximum allowed attachment size is 50MB. For large files, you
should use Links. You should also consider using Links if you have a large
amount of files and are worried about disk space, as attaching files to the
timeline will increase the overall timeline size.
• Since attachments are stored within the timeline file, you can move the
timeline file to any computer and still view the file. If you are using your
timeline on multiple computers, or wish to share it with others, consider
using Attachments.
• Since attachments are stored within the timeline file, you will be able to
access them on the iPad version of the application if they are an iPad
supported file format. If you are sharing your timeline between the Desktop
and iPad versions of Aeon Timeline, consider using Attachments.
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Reminders
Aeon Timeline provides the ability to create a list of reminders that you are able to
refer to when working on your timeline.
You can access these by opening the notifications window, which can be accessed
by the !

symbol on the toolbar.

The Notifications Window

Using the Reminders List
• Click the plus sign to add a new item
• Move items by holding and dragging the item by the move symbol on the
right
• Click the square to mark completed items.
• You can clear all completed items by clicking the Clear Completed option.
• To delete specific items from the list, click Select, and select the items you
want to delete, and click Delete.
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Bookmarks
Bookmarks are a way of saving specific points in time in your timeline. A bookmark
saves your zoom level and your scroll position. So if you need to jump from a
second-by-second action scene to a billion year history, bookmarks can save time.

Adding bookmarks
Click the Add button on the bookmarks bar at the bottom of the screen, or you can
click on the menu: Timeline > Bookmarks > Add Bookmark.

Removing bookmarks
Click the X button on the right side of a bookmark to remove it.

First and Last buttons
These buttons scroll the main view to the first and last event respectively.

Next and Previous buttons
Clicking on next will take you to the next event to the right of your current view.
Clicking on previous will take you to the previous event to the left of your current
view.

Sorting bookmarks
You can sort bookmarks by clicking on the menu: Timeline > Bookmarks > Sort by
Name / Sort by Date.

Two saved bookmarks
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Templates and Settings
Timeline Settings
Edit Your Timeline’s Template Using Timeline Settings
When creating a new timeline you start by choosing an initial template that defines
the date style, entity types and roles, properties and colors that can be used in your
timeline.
The Timeline Settings dialog allows you to edit the template used by your timeline.
Changes made in Timeline Settings are localised to your timeline – they will not
affect any other timelines using that template, or any new timelines you create from
the same template later.
If you want to save your template changes so you can use them in subsequent new
timelines, click on the Save As Custom Template button when you have finished
making your changes.

Range Settings
The Range tab allows you to edit details for the x-axis of your timeline. Most of the
time, this will relate to the Date properties of your timeline, but numeric timelines are
available that use numbers instead of dates.
Name: If you want to use a name other than the standard “Date” for this property,
you can change it here.
Style: Choose whether you want to use regular dates or one of the relative styles.
This setting is only available for date-based timelines and not numeric timelines.
Zoom Limits: Aeon Timeline is capable of zooming out to show billions of years, or
zooming in to show minutes and seconds. Use these values to specify the minimum
and maximum range of zoom allowed in the timeline.
Date Formatting: Choose the date and time format that you want dates to be
displayed in on the timeline.
Edit Calendar: Click on this button to edit the calendar used by the timeline and
create your own Custom/Fantasy calendar.
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Note that calendars can only be changed for new timelines before they have any
events or entities.

The Range Settings Menu

Property Settings
Properties are additional fields you create to store information about events in your
timeline. If you wish to track additional metadata fields relating to your event, you can
add properties using this window. You can also delete or edit existing fields.
You can set the following values for each property:
Name: A unique name used for the property.
Type: The type of value you want to store for the property. Allowed property types
are:
• Single-line text
• Multi-line text
• List of options
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• Integer number (whole numbers without a decimal component)
• Decimal numbers
• Currency
• Percentage (a numeric value from 0 to 100)
• Yes/No (a boolean value representing true/false, yes/no, on/off)
Calculating parent values
For numeric (integer, decimal, currency and percentage) and Yes/No properties, you
can choose to calculate the value for a parent based on the value of its
children. Situations where this may be useful would include:
• Project planning, where the percentage completion of a parent task is
determined entirely by the percentage completion of its children
• To-do management, where an event is only completed (Yes/No) when all
of its children are.
• Calculating costs of a project, where the costs of a parent task are based
on the sum of all of its children.
Tick the Automatically calculate parent’s value from children checkbox to turn
this feature on for the current property.
Mode: Specifies how child values should be used to calculate a parent, according to
the following options:
• Integer/Decimal/Currency:
• choose from sum, min, max, or average.
• Percentage:
• A single option, “weighted percentage“, is provided. This option
weights the contribution of each child based on its duration (e.g. a
child lasting 3 months will be given 3x the weighting of a child lasting
1 month).
• Yes/No:
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• Choose from All (parent is true only if every child is true) or Any
(parent is true if any of the children are true)
Fading events on the timeline
For certain projects, it can be useful to fade events on the timeline once they are
completed.
A single Yes/No or Percentage property can be used to determine whether an event
should be faded on the timeline.
Tick the Fade events based on this property checkbox to have events fade when
the selected Yes/No value is Yes/true, or when the selected Percentage value is at
100%.
Note that only a single value can be used to fade events. Turning it on for one
property will turn it off for all other properties.

The Properties Menu
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Entity Types and Roles Settings
Entity Types
Entity Types define particular classes of entities that can be added to your timeline.
Available entity types vary based on template, but may typically include types such
as Person, Location, Project, Story Arc, Character, Client, or Company.
Entity Types are important, as they can be used to divide your timeline into different
groups (e.g. you can group events by Project or Employee).
For each entity type, you can specify the following information:
Name: A unique name used for the entity type
Icon: The icon used to represent entities of this type in Relationship View.
Allow start/end events and age calculations: Whether this entity type should be
allowed to have birth and death events, and therefore be able to calculate entity
ages.
Generally speaking, you would only allow start/end events for entity types if you want
Aeon Timeline to calculate entity ages for you. This is very useful for fiction or
historical timelines, but may not be very useful for Project Management or Legal
timelines.
Roles
Each entity type is able to fill one or more roles for an event. A few examples to
illustrate this include:
• An employee may be able to fill different roles such as “Project Lead”,
“Developer”, and “Reviewer”.
• A character in a novel may fill a role of “Participant” in an event or
“Witness” to an event.
Every entity type must have at least one role, but are allowed to have more than one.
For each role, you can set the following:
Name: The name of the role. This must be unique across all names in your template
(including entity type names, roles in other types, and property names). The one
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exception to this is that one role may share the same name as its owning entity type
(e.g. an entity type called “Story Arc” can have a role called “Story Arc”).
Icon: The icon used for this role in the intersection of entities and events in the
Relationship View.
Allow multiple per event: Whether an event can have multiple entities fulfilling a
role, or whether it can only have a single value. For example, an event may be
allowed to be allocated to a single project only, but it may have multiple people
working on it.
When to add a new type vs when to add a new role
This depends on your individual circumstance and what you are trying to achieve,
but as a general rule of thumb:
• If the same entity may perform different roles for different events, then you
should add a new role to that entity type
• If no existing entity or entity type will ever fill a role, then it would make
sense to create a new Entity Type.
As an example, if an employee may sometimes act as a Manager and sometimes as
a Developer, depending on the event, they should be different roles.

The Entity Types Menu
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Color Settings
You can choose a color for each event using a dropdown list in the Inspector.
The Color section of Timeline Settings allows you to create and edit the colors that
are available in this list.
Colors have two properties:
Name: The name given to the color. Depending on your needs, this may be a color
name (e.g. Red, Yellow) or the meaning you want to give to a particular colour (e.g.
Critical, Trivial, Fred’s POV).
Color: The color to be used.
The default template colors are selected to stand out sufficiently across all of the
skins available in the application.

The Colors Menu
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Manage Entities
Accessing the Manage Entities Dialog
You can access the Manage Entities dialog by choosing Manage Entities in
the Timeline menu, or by clicking on the Manage Entities toolbar item !

.

The Manage Entities Dialog

Editing an Entity
The left-hand side of the Manage Entities dialog shows a list of all entities that
currently exist in your timeline, divided by their entity type. To view and edit a
particular entity, first click on the entity type to expand the list, and then click on your
chosen entity.
Note that entity names must be unique throughout the timeline (i.e. they cannot
share a name with another entity, even of a different type, nor can they share an
event with a field, entity type or role).
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Adding a new Entity
You can add entities using the dedicated Add Entity toolbar button in the main
interface, but it is also possible to add Entities in the Manage Entities dialog.
To add an entity in the Manage Entities dialog, do the following:
1. Click on the entity type that you wish to add.
2. Click on the green + symbol that appears next to the type name.
3. Enter a name for your new entity in the right hand part of the dialog.

Deleting an Entity
To delete an entity, select it in the list on the left-hand side of the dialog. Once
selected, hit the red Delete Entity button at the bottom of the right-hand section.

Configuring Entity Birth and Death
If your template is configured to allow it, Aeon Timeline is able to calculate entity
ages for every event it is associated with.
Before that can happen, you need to tell Aeon Timeline when your entity is born or
created (and optionally, when your entity dies or is destroyed).
There are two different options to provide that information:
• By typing a birth date directly into the Manage Entities window. This is the
simplest option.
• By specifying your entity’s birth as an offset from a given event.
Calculating a birth date from an event
If choosing the latter, you will need to specify the following information:
Event: The event to be used when calculating the entity’s birth date.
Offset: The offset from that event to use in the calculation, and whether it should be
calculated from the start of end of the specified event.
For example, an offset of -10 years from start will mean the entity is born 10 years
before that event. In other words, that the entity will be 10 years old when that event
occurs.
Aeon Timeline User Manual

!76

!

Aeon Timeline

Once a birth event is specified, the birth date will be calculated and displayed in
the Date field below that event. This field will be disabled so that you cannot edit the
birth date directly.
If the event is moved later, then the birthdate of the character will shift also.
Setting a death/destruction date
Setting a date for death or destruction is done in exactly the same way as described
above for birth/creation.
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Tags and the Tag Manager
What Are Tags?
Tags are another method of organizing your timeline. Tags are created in the
Inspector under the Values tab. Tags must be unique and cannot be empty.
Tags can be edited and deleted in the Tag Manager, which will then affect all of the
Tags in all events.
• To edit a tag, double-click it in the Tag Manager or the Inspector.
• To delete a tag, click the x on the right side of the tag.

The Tag Manager
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Aeon Timeline Options
Version Updates
Here you can change the update options. Periodically check for updates will check
via the internet occasionally.
Download available updates immediately will start a download as soon as Aeon
Timeline finds a new update.

Startup Options
Open last used timeline on startup will automatically open the last
opened timeline when you start Aeon Timeline.

Defaults for New Timelines
These are the default display settings for new timelines, that can also be found in the
Display Settings window. Skin is the default theme new timelines will start with
and Size is how zoomed in text and other elements on the timeline will be.

Preferred Date Format
Select the date order that you want to use when entering dates.
Use System Default will attempt to work out the date order automatically. If this fails,
you should set it directly.

Automatic Backup
Here you can select the folder where Automatic Backups are saved. Up to backups
can be saved, and a new backup is created when a timeline is saved and closed.

User Interface Behaviour
Pasting events includes dependencies lets copy and pasted events preserve
connections to dependent events. New events won’t be created to preserve
connections, instead a newly pasted event will have same connection to the
dependency.
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Options window on Mac

Options window on Windows
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Data Exchange
Scrivener and Ulysses Syncing
What is Scrivener and Ulysses Syncing?
The syncing feature lets you link events in your timeline with documents in your
Scrivener project or in Ulysses. Aeon Timeline will keep track of changes made to
timeline events or documents. Each time you sync, any changes made to the event
will be copied across to the corresponding fields for the document, and vice versa.
You can specify which fields in Aeon Timeline and Scrivener or Ulysses are used
when syncing. From Scrivener, we support syncing the project title, label, status,
synopsis, keywords, and any custom metadata fields that have been created. Almost
all values from Aeon Timeline can be included in a sync.

Terminology
Although Scrivener and Ulysses are similar in many ways, there are some slight
differences in terminology and the way each program structures their project.
Scrivener
In Scrivener, there is very little distinction between a folder and a text document.
Both can have nested folders and text documents within them, and both can have
text of their own (i.e. they are a document in their own right).
Therefore, in Scrivener, the distinction between a folder and text document is
somewhat arbitrary and it is up to the user to decide how they want them to be used.
For this reason, Aeon Timeline is capable of syncing with both text documents and
folders in a Scrivener project.
As the most common use case for Scrivener users is to sync only with text
documents and not folders, Aeon Timeline provides an option in Sync Settings to
Automatically ignore all non-text items (folders, PDFs, media, etc.). If you choose
this option, Aeon Timeline will assume that you do not want to sync with folders and
automatically ignore them - but it is still possible to override them on a case-by-case
basis.

Aeon Timeline User Manual

!81

!

Aeon Timeline

Ulysses
In Ulysses, there is a clear distinction between folders (called Groups inside
Ulysses) and documents (called Sheets). Ulysses Groups are simply a collection of
Sheets, and the Groups themselves cannot have any associated text or metadata
values.
For this reason, Aeon Timeline is only able to sync with Sheets in Ulysses. Syncing
with Groups is not possible.
Terminology Used
Within this documentation and the Aeon Timeline application, we have adopted a
uniform set of terminology across both Scrivener and Ulysses. For the most part, this
is based on Scrivener’s terminology, because that was the application we integrated
first and our existing users are familiar with those terms.
Specific terminology used within Aeon Timeline and this documentation includes:
• Document: This broadly refers to anything that Aeon Timeline can sync an event
with, namely any item (text document or folder) inside Scrivener, and a Sheet
within Ulysses.
• Text Document: More specifically, this is a text document inside Scrivener (any
item not marked as a folder), and a Sheet within Ulysses.
• Folder: A folder inside Scrivener, and a Group inside Ulysses.
• Binder: This refers to the tree-based user interface that shows the entire contents
of a project inside Scrivener, or the entire contents of the Ulysses library. This
terminology is shared with Scrivener.

Syncing with a Scrivener Project
To begin syncing your timeline with a Scrivener project:
1. Close your project if you have it open in Scrivener (Scrivener does not
allow opening or editing a project from two different applications at the
same time).
2. Access Choose Project -> Scrivener … from the Sync menu.
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3. In the Open panel, select your Scrivener project (file extension .scriv on
Mac and .scrivx on Windows). If you don’t have a Scrivener project yet,
you will need to create one via Scrivener before continuing.
If you are successful, a binder will open within Aeon Timeline showing the contents
of your selected Scrivener project. If this is the first time you have synced this
timeline with this project, the Sync Settings dialog will appear (see below).
If you try to sync to a project that Scrivener believes is open elsewhere, you will see
an error message in the Binder instead of the project contents. In that case, close
the Scrivener project and then click Retry.
If Aeon Timeline is giving you that error message and you are sure the file is not
open elsewhere, that means the last application to lock that file did not correctly
unlock it. In that case, you should open the file with Scrivener, press Continue when
it gives you a warning about the project being open elsewhere, and then close the
project again to clear the lock.
Note that any changes made to a Scrivener project by Aeon Timeline are saved
when the binder inside Aeon Timeline is closed. You should always close the binder
inside Aeon Timeline before opening the project in Scrivener. Otherwise, Scrivener
will show a warning that the project is open elsewhere.

Syncing with Ulysses
While Scrivener projects must be closed before syncing, Ulysses is the opposite: the
Ulysses app must be running when syncing occurs.
Unlike Scrivener syncing, syncing updates to Ulysses are applied live by sending the
changes directly to the Ulysses app.
To sync with Ulysses, access Choose Project->Ulysses from the Sync menu. If you
don’t already have the Ulysses open, this will automatically open it.
A binder will open within Aeon Timeline showing your documents in Ulysses.
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The binder (on the left) shows the contents of the synced project

Sync Settings Dialog for Scrivener Syncing
The sync settings dialog allows you to choose which fields to synchronise between
your timeline and your Scrivener document by selecting a value from a dropdown
box for each field of your timeline. For each field, you can:
• Select from one of the relevant existing fields inside your Scrivener project
(only relevant fields for a value will be displayed – e.g. keywords can only
be synced with tags. In Scrivener, the “Wrap Text” box must be checked
for any fields that you want to sync with multiline text properties, or with
any roles that allow more than one entity per event)
• Select ‘None’ if you do not wish for a timeline field to be synced to the
Scrivener document
• Select ‘New Custom Field’ if you wish to create a new custom meta-data
field inside your Scrivener document to display your timeline value.
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It will be quite common to select ‘New Custom Field’ for timeline properties such as
Start and End Dates or Duration, as most Scrivener projects will not have fields
setup for these values in advance.
If you change your mind and want to include or exclude fields at a later time, you can
change your current sync settings by clicking on the Settings icon !
in the top left
corner of the binder when you have your Scrivener project open inside Aeon
Timeline.
The Sync Settings dialog also contains an option to Auto-ignore non text items.
Scrivener allows you to add many different file types (folders, PDFs, videos, weblinks etc). If you choose this option in Sync Settings, anything that is not a text
document will be automatically ignored by default. You can still choose to sync to
individual items if you wish to, but if you follow a conventional structure, this will keep
all of the folders and other organisational elements out of your Warnings tab.

Sync Settings Dialog for Ulysses Syncing
The sync settings dialog allows you to choose which fields to synchronise between
your timeline and your Ulysses document by selecting a value from a dropdown box
for each field of your timeline. For each field, you can:
• Select ‘None’ if you do not wish for a timeline field to be synced to the
Ulysses document
• Select ‘Scoped Note’ if you wish to create a new custom note inside your
Ulysses document to display your timeline value.
In the metadata for Ulysses the event field title will appear as Note in the format
Name: Data. Therefore when you are trying to sync data that has been added to a
Ulysses document, it needs to be in this format and have the same name as the
Aeon Timeline event field to be able to sync it with Aeon Timeline.
Syncing can only occur with “Sheets” (i.e Documents), not “Groups”( i.e. folders).
Aeon Timeline will also ignore external folders and smart filters inside Ulysses, as
these are not compatible with syncing.
If you change your mind and want to include or exclude fields at a later time, you can
change your current sync settings by clicking on the Settings icon !
corner of the binder.
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The Project Sync Settings dialog when syncing with a Scrivener
project

Starting with an Existing Project
If you already have an existing project you have been working on for some time, and
you now wish to create a timeline that matches your project, simply perform the
following:
1. Open the project inside Aeon Timeline as described above.
2. Expand folders and documents within the binder tree to find the
documents from which you wish to create new timeline events.
3. Select a document from the binder and drag it into your timeline to create
a new event. Any existing metadata in the document will be copied across
to the new event immediately. If there is no metadata for the date or
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duration already specified in the document, the new event will be placed at
the date you dragged it to in the timeline.
4. Repeat this process for all events you wish to create. You can drag
multiple documents at a time from the binder.
5. Alternatively, if you right-click on a document in the binder and
choose Create event, a new event will be created at the centre of the
current timeline window (unless existing metadata overrides the dates).

Drag a document from the binder to the timeline to create a new
event. This document and event will now be synced with each other.
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Starting with an Existing Timeline
Conversely, if you already have an existing timeline you have been working on for
some time, and you now wish to push those events into a new document, simply
perform the following:
1. Open the project inside Aeon Timeline as described above.
2. Expand folders and documents within the binder tree to find the
documents from which you wish to create new timeline events.
3. Select events that you wish to add into your project, and drag them into
the binder. A new document will be created inside Scrivener or Ulysses
with all relevant fields copied across from the timeline event.
4. Repeat this process for all events you wish to create. You can drag
multiple events at a time into the binder.
You can safely move documents around inside the binder if you want to change their
position. These changes will be reflected when you next open the project inside
Scrivener, or in Ulysses.
If necessary, you can also create new folders or documents inside the binder,
rename documents, or move them to trash using the right-click context menu inside
the binder.

Dragging an event to the binder will create a new document in
scrivener. This event and document will now be synced with each
other.
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Starting with both Timeline and Project
If you are starting with an existing timeline and an existing project, this process is a
little slower, as you will need to specifically link existing documents with existing
timeline events.
To do so, you will need to do the following:
1. Open the project inside Aeon Timeline as described above.
2. Expand folders and documents within the binder tree to find the
documents you wish to link to existing events.
3. Right-click on the document, and choose Link to event… from the context
menu.
4. From the ensuing dropdown, select the timeline event you want to link it to.
You can type keywords or an event ID into the search field to narrow down
the list of options and find the event you want faster.
5. Repeat this process for each document/event pair that you wish to link.

Syncing an existing document to an existing event.
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Keeping Things in Sync
As you continue your work, you will make changes to both the timeline and
document so that the fields are no longer matched.
Each time you open your project inside Aeon Timeline, an icon next to the binder
documents will show you the sync status of each document:
• Document is not yet linked: !
• Document and event are up to date: !
• Document or event has changed: !
• Conflicting changes to document and event: !
• Document is marked to be ignored: [no icon]
You can hover your mouse over a document to see a tooltip with additional
information about the status, such as which values are conflicted or changed.

Syncing Changes
If one or more documents are marked as changed, click on the Sync All button !
at
the top of the binder to sync changes for all event/document combinations. Upon
clicking this button, any changes you made to documents will be copied across to
the timeline, and any changes to the timeline will be copied to the documents.
Any changes that are copied to documents in Scrivener will appear the next time you
open the Scrivener project. However, syncing between Ulysses and Aeon Timeline
happens simultaneously. When you sync something in Aeon Timeline you will see
the change in Ulysses almost immediately, and when you change something in
Ulysses you will see the change in the sync binder of Aeon Timeline.
Alternatively, if you wish to sync items individually, click on the document’s status
item inside the Binder or Warnings tab, or by choosing Show Item Status from the
context or Sync menus.
This will open the Item Status Popover. This provides a snapshot of the currently
selected Scrivener document or sync link.
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The Item Status popover shows:
• The document’s metadata values for all selected fields in Sync Settings.
• The linked event’s information for the same fields (if the document is
linked).
• If the document and event values are the same, the value is shown in a
single field stretching the width of the popover.
• If either the document or event value has been edited, the document and
event values are shown in separate columns. Any changes since
the document’s last sync are shown in green (additions) or
orange (deletions).
• Any conflicts are highlighted with a red boundary.

The Item Status Popover for an event.

Wherever the timeline and document values differ, you can choose which value you
wish to keep when applying a sync:
• The currently chosen option will be highlighted with a bold outline.
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• Click on the Choose button in the other column to switch to the other
value.
• In the case of a conflict, neither option will be chosen by default.
Click Choose in one column or the other to choose that value. You cannot
sync a document until all conflicts have been resolved.
• If the values differ but can be merged (e.g. a keywords list), then you won’t
get the option to choose one value or the other.
Once the selections are configured the way you want them, click Sync Now to apply
those changes immediately.

Warnings Tab
The warnings tab lists three distinct types of warnings:
• Conflicts: Lists any conflicted links – that is, links where the same value
has been edited inside both Aeon Timeline and Scrivener/Ulysses, which
requires manual intervention to determine which version to keep when
syncing.
• Linked to deleted events: Lists any items that are linked to events that
no longer exist in the timeline.
• Unlinked documents: Lists all documents that are neither ignored, nor
linked to a Timeline Event. This allows you to see any new documents in
the project.
Clicking on any items in the Warnings tab gives you access to the same options as
you would have when accessing them inside the binder itself.
You can also hold down Shift to select multiple documents within the one category,
allowing you to quickly apply the same decision (e.g. Ignore, Create New Event) to
all of the selected items at once.
The number shown at the top of the Warnings tab tells you the total number of
documents across the three categories. The number badge will be coloured red if
there are any conflicts, and orange otherwise.
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The Warnings Tab

The Events Tab
Where the new Warnings tab draws attention to documents that require specific
attention, the new Events tab does the same thing for timeline events.
The events tab lists events in two categories:
• Linked to deleted items: Lists any events that are linked
to documents that no longer exist in the project.
• Unlinked events: Lists all Timeline events that are neither ignored, nor
linked to a document. This allows you to see any new events in the
timeline that you may want to import into the project.
Clicking on the status icon next to an event will select the event in the timeline and
scroll it into view.
The context menu provides access to options to resolve the issues, including:
• Remove Link: Removes the existing link and moves the event into the
Unlinked events category.
• Ignore: Mark the event as ignored to remove it from the list.
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• Create new document in Inbox: Creates a top-level folder in your project
called Inbox (if it doesn’t already exist), and then adds a new document
linked to this event to that folder.
The Create in Inbox option provides a fast way to sync a number of new events at
once, rather than seeking them out in the Timeline and dragging them into the
Binder.
As with the warnings tab, you can hold down Shift to select multiple events within
the one category to apply the same action to all selected events.

The Events tab

Ignoring Documents
If there are documents that you know you will never want to sync, you can choose to
permanently ignore those documents by right-clicking on the document and
choosing Ignore.
Ignored documents will no longer show a status icon, and you can choose to hide
ignored events entirely from your binder.
You can also ignore entire subtrees of documents. This option is found in the context
and sync menu for a selected item. This ignores not only the selected item, but all
children of that item now and in the future. This allows you to automatically
ignore top-level folder such as Research and Trash, and never be bothered with
items in those folders appearing in your Warnings tab.
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Binder Display Options
At the bottom of the binder there are two display options that you might find useful.
Show Unchanged Items
When this is unchecked, all unchanged items will be removed from the binder (i.e.
all items showing !

). The only items showing will be those with changes !

or those

that are not yet synced ! , plus any parents of those items (to maintain the integrity
of the tree structure).
This can significantly reduce the number of documents visible in the binder, making it
easier to find items that have changed.
Show Ignored Items
By default, ignored items will be removed from the binder (unless their child
documents must be displayed.
When this is checked, those items will be displayed. Allowing you to review the
ignored items and potentially drag them onto the timeline or link them with another
event.

The display options at the bottom of the binder

Project Filter
If you want to quickly find an item inside the Project Binder and know the document’s
title, you can use the filter textfield at the bottom of the binder to search for that
document.
As you type, the binder list will be filtered to show only documents that match the
entered text.

Syncing Links in Inspector
Aeon Timeline automatically creates an external link whenever an event is synced
with a document. These automatic links are shown in the Links tab in the Inspector,
under a separate category from the other links.
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This provides a way for you to see which document an event is linked with (this
information was not easily accessible in earlier versions).
This link will be visible, even if the project is not open at the time.
The links tab allows you to perform the following actions for Scrivener documents
only:
• (Mac-only) Click the Quicklook icon to view the actual document contents
in a Quicklook window.
• (Mac-only) Click the Open icon to open that selected document inside
Scrivener. This will launch Scrivener and try to open the project, so you
should close the project inside Aeon Timeline first.
• If the Scrivener project is currently open for syncing, click on the red minus
button next to the document to unlink the event from the document.
Note that since timelines can sync with multiple projects, there may be more that one
document listed in the Syncing area of the links tab.

The links tab showing what document the event is linked to

Manage Projects
Found in the Sync menu, this shows a list of all projects the timeline is currently
synced with. Within this window, you can erase all sync data related to a project.
This is useful if you want to erase an existing sync to start again, or to remove
projects you no longer care about so they don’t show up in the Inspector).
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Import/Export CSV
How to Import a CSV File
To import events from a CSV file into your current timeline, perform the following
steps:
1. Ensure your CSV file meets the rules listed for valid CSV files below. In
particular, ensure the file uses UTF8 encoding.
2. Select Import -> CSV… from the File menu.
3. Choose the CSV file you wish to import.
4. In the Import CSV dialog (shown left)
• Select whether your file is using Comma or Tab as the delimiter for
columns within a row.
• Select whether your file is using Comma, Pipe (|) or Either as the
internal delimiter for fields with multiple values.
• Specify whether the first row in the CSV file contains column
headers, or whether the data to import begins in the very first row.
Note, it is generally recommended to use a CSV file with a row of column names at
the top, as it will make the next step much easier.

Import CSV Dialog
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Specify How To Handle Each Column
The next import screen lets you specify what you want to do with each column of
data in the CSV file.
A separate dropdown will be shown for each column of data, allowing you to choose
the timeline field that the column should be matched with. When importing, you are
able to specify columns to use for the event title, dates and duration, color, tags,
links, and any properties and roles specified in your chosen template.
If your CSV file contains a header row (as per previous import screen), each
dropdown will be labeled with the column name, making it easier to match up each
column with the intended result. Otherwise, the columns will be labelled as “Column
A”, “Column B”, etc.
No two columns can be paired with the same field in the timeline (i.e. selections in
the dropdowns must be unique). Title and Start Date are the only mandatory fields
that you must select somewhere.
Note that Aeon Timeline will always create new event IDs for imported events.If you
CSV file contains a column for event IDs, you should generally set this field
to Ignore. Ids in CSV files are only used to specify a parent/child relationship
between events. (See more about this below).
Once you are happy with your selections, click Import to add the events into your
timeline file. Depending on the size of your CSV file, this may take several seconds
to complete.

Rules for CSV Files
In order to import data from a CSV file, the file must conform to the following rules:
• Your file must use a csv or txt extension.
• Files should be in ASCII or UTF-8 file format. Other Unicode formats and
UTF-16 may not import correctly and should be converted to UTF-8.
• One record is entered per line. There must be no newline characters within
a record.
• The fields within each record must be delimited with either commas (,) or
tabs.
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Choosing which csv columns are imported into which Aeon Timeline properties

• Each record should contain the same number of fields/delimiters. It is
acceptable to leave some fields empty, but their delimiters must remain
intact.
• Any field values that include the value delimiters (i.e. comma or tab,
depending which is used to delimit each value) must be included in
straight double quotes ("). Optionally, all fields can be enclosed in these
quotes.
• If you are using the comma as both an internal and external delimiter, all
columns containing internal delimiters must be enclosed in straight double
quotes (").
• Curly quotes must not be used when surrounding values.
• Any double quotes within field values must be escaped by placing a
second double quote next to the first. For example, the text She said "It’s
me!" would need to be written as "She said ""It’s me!"""
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Unfortunately, there is no single standard that defines how a CSV file should be
created. We have tried to adopt the most universal standard available, but you may
need to massage data from some applications in a text editor before importing.
Converting to UTF-8 format
If your timeline file is not already in UTF-8 format, you will need to convert it to UTF-8
format before you can import it.
Mac OS X
1. On Mac, you should be able to open your csv file with TextEdit and convert
it as follows:
2. Hold down the Alt key and click on the File menu.
3. Choose Save As…
4. In the save dialog, change the Plain Text Encoding dropdown,
choose Unicode (UTF-8).
Windows
On Windows, many tools are available to convert to UTF-8 format. You can
download a text editor such as Notepad++ and open the file.
1. Using Notepad++, you can do the following:
2. Open the file in Notepad++.
3. Click on the Encoding menu, and choose your current file encoding by
choosing Encode in XXX.
4. Open the Encoding menu again, and choose Convert to UTF-8.
5. Save the file (you can use Save As and change the file name if you wish).

Multi-Value Columns
Some columns, such as columns representing a “Role”, may allow multiple values
for a single record… e.g. an event may have more than one Person in the role of
Witness.
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In such instances, each value inside your CSV file should be delimited using a pipe
character ( | ) or comma (,). This is known as the internal delimiter, and you can
specify which one your CSV file is using upon import.

Importing Nested Events
To import events with a parent/child relationship, your CSV file needs to contain a
column which contains a unique ID for each event. It also should contain a separate
column that contains the unique ID of the event’s parent. When you are specifying
how to handle each column, you choose these columns for “Unique ID” and “Parent”
respectively, which will import the parent/child relationship between the two events.

Exporting CSV Files
Aeon Timeline can export timeline data to a CSV file as well as read it. This can be a
useful way to share timeline data with other applications.
To export to a CSV file, choosing Export To -> CSV from the File menu, and choose
where to save the exported file.
The exported file will follow the CSV rules defined above, and use UTF8 encoding.
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Exporting Image/PDF
Important Note for Mac Users
As the Mac save dialog does not currently show a list of available extensions, you
will need to type the file extension with the filename, or it will default to PNG.
For example, if you want to export to a PDF file, you should type “abc.pdf” as the file
name.

How to Export an Image or PDF of Your Timeline
To export your timeline to an image, perform the following steps:
1. Adjust your timeline until it looks the way you want it to when exported,
including:
• Zooming to the desired level
• Grouping by the desired entity type
• Collapsing groups you do not want to print
• Applying a filter to reduce the number of visible events
2. Select Export -> Image from the File menu.
3. Choose whether you want to export:
• Just the current window (as displayed on your screen)
• Your entire timeline, from the first event to the last
• A specific date range (entered in the Start/End date pickers further
down the window)
4. Windows users: click OK to bring up the save dialog. Mac users will
already have the save dialog open at this point.
5. Choose a location and enter a file name for the file. Aeon Timeline can
export to the following file formats:
• PNG (recommended, extension *.png)
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• JPEG (extension *.jpg or *.jpeg)
• BMP (extension *.bmp)
• PDF (extension *.pdf)
Depending on the size of the image you are exporting, the image may take several
seconds to complete the export.
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Export to Web
Exporting Your Timeline for the Web
Aeon Timeline can export your timeline into a browser-friendly format that can be
opened by most modern web browsers (tested on the latest editions of Chrome,
Firefox, Safari, and Microsoft Edge, with limited support for Internet Explorer).
The web export is a read-only view of the timeline that mirrors the presentation of the
timeline inside the Aeon Timeline application. Someone viewing a web-exported
timeline can scroll, zoom, and search within the timeline, as well as expand/collapse
individual groups and events.
This may be useful for a range of purposes, including:
• Sharing a read-only version of the timeline with others who do not have a
copy of Aeon Timeline
• Using Aeon Timeline in a presentation where you cannot install our
application (e.g. a courtroom)
• Publishing your timeline, or parts of your timeline, to the web

How to Export Your Timeline
To export your timeline for the web, do the following:
1. Choose Export -> Web from the File menu.
2. Select the folder you wish to export to. It is recommended that you create
a new folder as there are many files saved during the web export.
The web export will create a number of items inside your selected folder, including:
• Folders for css, font-face, images, and js (javascript)
• aeontimeline.html
• aeontimeline_data.js
When distributing your timeline to others or uploading to the web, you will need to
include all of these files.
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To view the exported timeline, double click on the aeontimeline.html file, or open it
in your preferred browser.
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Printing
How to Print Your Timeline
To print your timeline, perform the following steps:
1. Adjust your timeline until it looks the way you want it to when printing,
including:
• Zooming to the desired level
• Grouping by the desired entity type
• Collapsing groups you do not want to print
• Applying a filter to reduce the number of visible events
2. Select Print… from the File menu.
3. The print options dialog will be displayed.
In this dialog, you can:
1. Set the preferred Skin for printing. Aeon Timeline comes with a printerfriendly “black text on white background” skin called Print.
2. Adjust the scaling for the printing. Scaling the text in this dialog will give
better clarity than using the native scaling that is part of the OS or your
printer.
3. Select whether to print:
• Just the current window (as displayed on your screen)
• Your entire timeline, from the first event to the last
• A specific date range (entered in the Start/End date pickers further
down the window)
4. If printing a date range or the entire timeline, you can choose whether
to Print expanded groups only.
• With this option checked, any collapsed groups will be omitted from
the printing entirely.
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The Print Options dialog

• Otherwise, they will be printed as “collapsed groups”.
When you are happy with your Print Options, click OK.
You will then be shown the native print dialog for Mac or Windows, where you can
select your preferred printer, page ranges etc. before printing.
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Support and Updates
Updates
Updates for Aeon Timeline are released periodically to fix reported bugs and add
new features. All version 2.x updates are free for users with an existing version 2
license.
To ensure you are running the latest version, do the following:
• On Mac: Choose Check for Updates… from the Aeon Timeline menu.
• On Windows: Choose Check for Updates… from the Help menu
Alternatively, you can always download the latest version of Aeon Timeline from our
website at:
http://www.aeontimeline.com/download/

Help and Support
Further support information including videos, tutorials, and support documentation is
available on our website, http://www.aeontimeline.com/
If you have questions that are not answered, please post a question to our website
forum, where your question will be answered by either one of our support staff or
another Aeon Timeline user.
Alternatively, you can send an email to: support@aeontimeline.com
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